The Muvipix.com Guide to Vegas Movie Studio HD Platinum 10

Chapter 2
Start a New Project

Smart beginnings

Now matter how great the journey ahead,
it all begins with a few simple steps.

And, no matter how simple or how
complicated your movie project is, setting
your project up correctly can go a long
way toward ensuring a successful editing
experience.

The Welcome Screen
Selecting Project Properties
Match Media Settings

Project Properties
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CHAPTER 2

Your project settings determine how the program “digests” the media you

load into your project.

In most cases, you'll want your project settings to match your source

video as closely as possible. But, if you're mixing media in more than one
format, your project settings can also determine how this other media is

interpreted by the program.

Although Vegas Movie Studio HD allows you change your project settings

at any point in your work, it's always best to select the correct settings

when you first create your project.

Start a new project

Project Edit Vi There are four ways to start a new project in Vegas Movie Studio HD:

e « From the Welcome Screen, select the New option. (For more

information on the Welcome Screen, see the sidebar below.)

« Selecting the New option under the File menu

« Press Ctrl+n on your keyboard.

+ Clickon the u"blank page” icon on the Toolbar.

The first two methods will open the New Project dialog window — always
the best place to start a new project.

Clicking on the button the Toolbar opens directly into a new project
based on your current default project settings.

Hew Project

Audio:

Video:

Name:

The Welcome Screen

Open a project.

The Welcome Screen is the dialog

screen that greets you when you RecefPrjgts:
first launch the program. Hordaa |
From this screen, you can start ¥

=l open

a new project, open an existing
project or view tutorials.

By unchecking the option in the
lower left of this screen, you can

Create a new project.

4 New
l@ Create 8 Vegas Movie Studis project using
cOMMOon presets

Show Me How Tutorials
[} Leam how to use Vegas Movie Studio with
interactive tulcrials
4

Start Using Vegas Maovie Studio

A Closa this window and start using Vegas Mevie
Studis

.‘r' \".

L i

launch directly to the Vegas Movie
Studio HD editing workspace.

selecting Customize Toolbar.)

£ Showataaup
skip the Welcome screen and -
. Unchecktoskip  Launch tutorials. Go to the Vegas Movie
the program WI”' from then on, this screen. Studio editing workspace.

The Welcome Screen can also be launched at any time from within the program by
clicking the ﬁ button on the right end of the Vegas Movie Studio HD Toolbar. (If this
button isn't on your Toolbar, you can easily add it by going to the Options menu and
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Region: | Americas and Japan (60 Hz / NTSC) V1

Folder: . E:\VegasMovieStudioProjects\Summer Travels\

The New Project Dialog Window

—
a4

(@ stereo (0 5.15urround

| Project: | 1920x1080-60i

|avarD

{HDV = 1440x1080-60i

|DV Tl
{ovD /

leu-ray Disc >

| Internet Video

| Match media settings -._._.___,__________‘_____‘_‘_‘_
| Use this setting for projects that use video from AVCHD cameras. |

| Video: 1440x1080, 29.970 fps interlaced.

| Summer Travels

Free storage space in selegted
Manage project files (requires named project)

[ ok | [ cancl

Select settings in the New Project dialog box
The New Project dialog box launches when you select the option to start a
new Vegas Movie Studio HD project.

Select a Region
If you are in the United States, Canada or the rest of the Americas, or in
Japan, you should select the NTSC option.

If you are in Europe or Asia, you should select the PAL option.

Select your Audio format

If your camcorder shoots in 5.1 audio or you plan to use 5.1 audio as an
audio source, select 5.1 Surround. Otherwise, select Stereo.

Select your Video format

You can select your Video format either based on the type of
camcorder your video came from or based on the format of video you
plan to output.

For best results and program performance, we recommend that
you always set your project up based on your source footage - the
camcorder format that your video was recorded in.

Start a New Project

In Vegas Movie Studio HD,
you have the option of
setting up your project
based on the format of

of your source video...

.or based on the format
of video you plan to
output...

...or you can match your
project’s settings to
existing footage.

Naming your project
and checking the option
to Manage Project

Files tells the program
to save all of this
project’s files in the
same folder set.
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CHAPTER 2 Setting Up Your Project Correctly

Start a New Project

New Project ?

X

Region: | Americas and Japan (60 Hz /NTSC) :]

Audio: (®Stereo () 5.1 Surround

Video: | |AVCHD Project: [ 1520x1080-60i
HDV 1440x 1080-60i

ov

DVD

EBluray Disc

Internet Video

Match media settings

Use this setting for projects that use Ful HD video from AVCHD cameras.
Video: 1920x1080, 29.970 fps interlaced.

There are three project presets based on your source video:

AVCHD is video from high definition hard drive camcorder.
AVCHD comes in two formats: 1920x1080 pixels and
1440x1080 pixels. Both of these formats are the same high-
definition resolution. One format uses square pixels and
the other uses pixels that are wider than they are tall. Check
your camcorder specs to ensure you're selecting the correct
settings.

HDV is tape-based high-definition video. HDV can be full
high-def 1440x1080 or “Lite” 1280x720. Again, check your
camcorder’s specs to ensure you select the setting that best
matches your source video.

DV is video from a tape-based miniDV or Digital8 camcorder. DV
video can be standard 4:3 or widescreen 16:9.

To set your project up based on the format you plan to output, select
one of the following options. The program will interpret any video
you add to your project so that it is optimized for your output format:

DVD optimizes your project’s video for either a standard 4:3 or
widescreen 16:9 DVD.

Blu-Ray Disc optimizes your project’s video for eventual output
as one of four Blu-Ray disc video formats.

What is 24p?

24p is video that plays ~24 non-interlaced frames per second
(rather than the standard 25 or 29.97).

24p video tends to have a a more “filmic” look.
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Match Media Settings

When you select the option BEVIIONEC, 78
to Match Media Settings, a
Browse button will appear
on this dialog screen. Use
the Browse button to (o Sl
locate a sample clip of the o
video you will be using in Internet Video
your project. Vegas Movie
Studio HD will automatically
create a project setting that
matches this video format
as closely as possible.

Region: | americas and Japan (60Hz /NTSC) ||

Audio: (®)Sterea () 5.1 Surround

Use the Browse button to match your project settings to a media fle on your hard drive.

Video: 640x430, 30.000 fps progressive.

The program does a very good job of matching its project settings to your selected clip — but
it's not perfect. Some video formats (such as video from Flip camcorders, FRAPS programs or
digital still cameras) use codecs (compression methods) that aren’t possible for the program
to match exactly, while other video formats (DivX, for instance) are virtually uneditable and
need to be converted to more standard editing format before you'll be able to work with
them in Vegas Movie Studio HD 10.

In these cases, when you bring the video into your project, the program may seem to
perform sluggishly or require constant pre-rendering of your project. When this happens, it’s
often wiser to convert the video to a more traditional DV-AVI or MPEG2.

Internet Video optimizes your video for display on a web site
as either high-definition 1280x720 pixels, standard definition
640x480 pixels or widescreen 640x360 pixels.

If you've no idea which Video setting to select, you can always
choose to Match Media Settings, as discussed in the sidebar above.

Name your project

It's not necessary to name and select a “save” location for your
project at this point. (You can do so at any point in your work by
going to the program’s File menu and selecting Save As.)

But doing so allows you to manage your project files, as described in
the next step.

At Muvipix we recommend that, whenever you start a new project,
you create a new folder for it. This is just “good housekeeping,” but
it can make managing your project’s media files much easier.
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Name: [ Summer Travels |

Folder: | :\VegasMovieStudioProjects Summer Travels\ _J [ Browse... |

Free shuragemacensdec&df;def 70.1 Gigabytes
[¥]Manage project files (requires named project)

Lo | [ coxel |

5 Select the option to Manage Project Files

When you select the option to Manage Project Files, a sub-folder
will be created in your project folder into which the program will
save your captured video and temporary render files.

This keeps all of your project’s files in a single place - making it
much easier to clear all of the files associated with a project when
your project is done and you want to reclaim your hard drive space.

Change Project Properties

Even after you've started editing your project, you can
i change your current project’s Properties by clicking on
a the button at the top of the Preview window. The Project
Properties dialog window offers more detailed options
than the New Project dialog.

In fact, there are a couple of properties here that you should set and lock
in permanently:

Full Resolution Rendering Quality
We recommend you set this to Best.

Deinterlace Method

Make sure that this is set to either Blend Field or Interpolate Fields. (There
is a lot of debate over which is better, although in truth the results are
pretty much identical.)

Interlacing has to do with how your TV or computer draws a frame of
video onscreen. An interlaced frame is drawn one horizontal line of pixels
at a time, drawing every other line in the first pass and then drawing the
lines in between in the second pass. This happens 25-30 times a second,
so it’s too fast for your eyes to see it.

Some video formats (AVIs, for instance) create their interlaced frames
using the lower field of lines first. Others (MPEGs, for instance) create theirs
using the upper field of lines first. And some use progressive scan, which
uses no interlacing whatsoever.

The Project Properties Panel

Start a New Project

Selecting the option to use a Blended or PraTeetPrOpErtes ? X
Interpolated deinterlacing method tells

L . Video | Audio | Ruler | Summary | Folders
the program to minimize the differences

. L T : | NTSC DV (720x480, 29.970 ‘
between your source video and the project’s o o i v|@ X B'_J
settings. Width: 720 Field order: Lower field first v|
Height: 480 Pixel aspect ratio: [0.9091 (NTSC DV) ;:i

In addition, we recommend that you check R Py |
the option to Adjust Source Material to : — :
Better Match Project or Render Settings. Full-resolution rendering quality:  |Best ||
Deinterlace method: |Blend fields v

Set Project Properties default

If you check the option to Start All New
Projects With These Settings, your future
projects will automatically be set up with the
video and audio properties currently selected
on this dialog window.

[+] Adjust source media to better match praject or render settings

If you tend to work with similar video formats,

this can simplify your project’s set-ups. You _ _
. . [¥] start all new projects with these settings
can then go right to the editing workspace
for a new project by clicking theu button Coox_ ] [Lconcel ] [_Aooy_]
on the Toolbar.

Video, Audio and other Project Properties
On the Project Properties dialog, you can ensure that your video and audio
are set properly for your project — and you can change them if you need to.

Under the Video tab, for instance, you can select one of any of 17 Templates
from the drop-down menu, or you can manually set the individual properties.

As arule, it’s probably not wise to edit your video with one set of properties
and then suddenly switch them halfway through. But, if you suddenly realize
midway through your project that you're editing in standard video when you
meant to be editing in hi-def, this dialog is where you make the swap.

Cut and paste between projects

If you need to, you can cut and paste clips, events or even entire sequences
from the timeline of one Vegas Movie Studio HD project to another.

1 Select the clips you want to cut or copy
With one project open, select the events or clips you want to cut or
copy.
To select several events at once, hold down the Ctrl key as you select
your clips on the timeline.

You can also Group your clips so that they all stay together and you can
grab them all at once (page 94) or use the Selection Edit Tool (page 86)
to lasso your clips or events.
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Vegas Movie Studio HD includes the option of having more than one instance of the program open at once,
enabling you to cut and past clips or even sequences between two projects’ timelines!

2 Select the option to Copy or Cut

You can select the option to Copy or Cut from the Edit menu, select
the option from the right-click menu or use the keyboard shortcut
(Ctrl+c or Ctrl+x).

3 Openasecond instance of Vegas Movie Studio HD

Launch Vegas Movie Studio again from the Windows Start menu or
by double-clicking on the desktop shortcut. The program will open
as a second instance, independent of your original project.

Open the project that you want to paste your clips into in the

second program instance.

4  Paste to the second project’s timeline

To paste, select the option from the Edit menu, select the option
from the right-click menu or use the keyboard shortcut Ctrl+v.

Your video sequence will paste to the armed track at the position of
the Timeline Cursor (playhead).

For information on arming a video or audio track, see page 71 of
Chapter 6, Edit Video On The Timeline.
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